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Using the NFC feature (Optional)
 

If you want to add NFC feature to the machine, check the option lists and 
contact the purchasing point to order (see "Available accessories" on page 
58). When you purchase a Wireless/NFC Kit (Wireless LAN Option), install the 
kit by following the steps described in the Wireless/NFC Kit (Wireless LAN 
Option) guide which is enclosed in the kit. After installing the Wireless Kit 
(Wireless LAN Option), set the machine to use this feature.

 

The NFC (Near Field Communication) printer allows you to directly print from 
your mobile device just by holding your mobile device over the NFC tag on 
Wireless/NFC Kit (Wireless LAN Option). It does not require installing print driver 
or connecting to an access point. You just need NFC supported mobile device. 
In order to use this feature, mobile apps needs to be installed on your mobile 
device. The default in your machine is NFC on.

 

• Depending on the material of the mobile device cover, NFC recognition 
may not work properly.

• Depending on the mobile device you are using, the transmission speed 
may differ.

• This feature is available only for the model with a NFC tag (see "Machine 
overview" on page 17).

• Using a cover or a battery other than the ones that came with the mobile 
device, or a metal cover/sticker can block NFC.

• If NFC devices keep failing to communicate,

- Remove the case or cover from the mobile device, then try again.

- Reinstall the battery from the mobile device, then try again.
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Requirements

• NFC and Wi-Fi Direct enabled, supported mobile apps installed mobile 
device with Android OS 4.0 or higher.

 

Only Android OS 4.1 or higher will automatically enable the Wi-Fi Direct 
feature on your mobile device when you enable the NFC feature. We 
recommend you to upgrade your mobile device to Android OS 4.1 or higher 
to use the NFC feature.

 

• Wi-Fi Direct feature enabled printer (see "Setting up Wi-Fi Direct" on page 
148).
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Related Apps

There are some apps that can be used with the NFC feature. The apps can be 
downloaded from the Google Play Store.

• Samsung Mobile Print: Enables users to print, scan(Only users with multi-
functional printers), or fax(Only users with multi-functional printers) photos, 
documents, and web pages directly from your smartphone or tablet (see 
"Using the Samsung Mobile Print App" on page 157).

• Samsung Mobile Print Pro: Helps users to get an authentication easily. This 
app provides one way of getting a user authentication using your mobile 
device (see "Using the Samsung Mobile Print Pro App" on page 152).
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• Samsung Mobile Print Manager: Enables users to use cloning and wireless 
setup features using your mobile device (see "Using the Samsung Mobile 
Print Manager App" on page 154).
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Using the Samsung Mobile Print Pro App

You can use it to get an authentication/registration from the Samsung Mobile 
Print Pro app.

Authentication from the mobile device

1 Check that NFC and Wi-Fi Direct enabled features are on your mobile 
device and Wi-Fi Direct feature is enabled on your printer.

2 Open Samsung Mobile Print Pro app.

 

If you do not have Samsung Mobile Print Pro installed on your cellphone, 
go to the application store (Samsung Apps, Play Store) on your mobile 
device, and just search for download the app and try again.

 

3 Type in the ID and Password.

If necessary, type in the ID and Password to log in. If it’s your first time 
logging into the printer, type in the below default ID and password. We 
recommend you to change the default password for security reasons.

• ID: admin

• Password: sec00000 

 

If you want to create a new user or change the password, see "Security tab" 
on page 208.

 

4 Tag your mobile device (usually located on the back of the mobile 
device) over the NFC tag( ) on your printer.

Wait few seconds for the mobile device to connect to the printer.
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For some mobile devices, NFC tag might not be located at the back of the 
mobile device. Check the location of the NFC antenna on your mobile 
device before tagging.

 

 Registration from the mobile device

1 Check that NFC and Wi-Fi Direct enabled features are on your mobile 
device and Wi-Fi Direct feature is enabled on your printer.

2 Open Samsung Mobile Print Pro app.

 

If you do not have Samsung Mobile Print Pro installed on your cellphone, 
go to the application store (Samsung Apps, Play Store) on your mobile 
device, and just search for download the app and try again.

 

3 Press the  icon on the Samsung Mobile Print Pro screen.

4 Select On from the Phone login set as default menu.

5 Mobile device ID appears on the Samsung Mobile Print Pro screen.

Press Registration.

6 Type in the ID , Password, Domain and Password, then click OK.

 

• If you want to create a new user or change the password, see "Security 
tab" on page 208.

• Passcode is for when the administrator chooses Two-Factor 
Authentication method. You need to enter a passcode for 
authentication. Password and passcode should be different. You can 
select Two-Factor Authentication from the SyncThru™ Web Service, 
select Security > User Access Control > Authentication > 
Authentication Method > Options  button > Login Method > Two-
Factor Authentication.

 

7 Tag your mobile device (usually located on the back of the mobile 
device) over the NFC tag( ) on your printer.

Wait few seconds for the mobile device to connect to the printer.
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For some mobile devices, NFC tag might not be located at the back of the 
mobile device. Check the location of the NFC antenna on your mobile 
device before tagging.

 

8 Registration complete message appears on the printer’s touch screen.
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Using the Samsung Mobile Print Manager App

If you have more than one printer and need to set the same settings on each 
printer, you can easily do it using the Samsung Mobile Print Manager app. 
Touch your cellphone on the NFC tag on your printer to copy the settings and 
tap on the printer you want to set the setting.

 

When exporting the data, you can save more than one data. When 
importing the data, you can select the data from the list and import.

 

Exporting(Copying the setting to your mobile 
device)

1 Check that NFC and Wi-Fi Direct features are enabled on your mobile 
device and Wi-Fi Direct feature is enabled on your printer (see "Setting 
the Wi-Fi Direct for mobile printing" on page 148).

2 Open Samsung Mobile Print Manager from your mobile device.

 

If you do not have Samsung Mobile Print Manager installed on your 
cellphone, go to the application store (Samsung Apps, Play Store) on your 
mobile device, and just search for download the app and try again.

 

3 Press Export.

4 Type in the ID and Password, then click OK.

If necessary, type in the ID and Password to log in. If it’s your first time 
logging into the printer, type in the below default ID and password. We 
recommend you to change the default password for security reasons.

• ID: admin

• Password: sec00000

 

If you want to create a new user or change the password, see "Security tab" 
on page 208.
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5 Tag your mobile device (usually located on the back of the mobile 
device) over the NFC tag( ) on your printer.

Wait few seconds for the mobile device to connect to the printer.

 

• For some mobile devices, NFC tag might not be located at the back of the 
mobile device. Check the location of the NFC tag on your mobile device 
before tagging.

• While cloning, the machine is locked.

 

6 Select the settings you want to apply and press OK.

7 Follow the instruction on the mobile device’s screen.

Importing (Applying the settings to the machine)

1 Check that NFC and Wi-Fi Direct features are enabled on your mobile 
device and Wi-Fi Direct feature is enabled on your printer (see "Setting 
the Wi-Fi Direct for mobile printing" on page 148).

2 Open Samsung Mobile Print Manager from your mobile device.

 

If you do not have Samsung Mobile Print Manager installed on your 
cellphone, go to the application store (Samsung Apps, Play Store) on your 
mobile device, and just search for download the app and try again.

 

3 Press Import.

4 Type in the ID and Password, then click OK.

If necessary, type in the ID and Password to log in. If it’s your first time 
logging into the printer, type in the below default ID and password. We 
recommend you to change the default password for security reasons.

• ID: admin

• Password: sec00000 

 

If you want to create a new user or change the password, see "Security tab" 
on page 208.

 

5 Select the settings you want to copy.
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6 Follow the instruction on the mobile device’s screen.

7 Tag your mobile device (usually located on the back of the mobile 
device) over the NFC tag( ) on your printer.

Wait few seconds for the mobile device to connect to the printer.

 

• For some mobile devices, NFC tag might not be located at the back of the 
mobile device. Check the location of the NFC antenna on your mobile 
device before tagging.

• While cloning, the machine is locked.

 

Wireless Setup

You can copy wireless setting from your phone to your printer by touching your 
mobile device on the NFC tag on your printer.

1 Check that NFC and Wi-Fi Direct features are enabled on your mobile 
device and Wi-Fi Direct feature is enabled on your printer (see "Setting 
the Wi-Fi Direct for mobile printing" on page 148).

2 Open Samsung Mobile Print Manager from your mobile device.

 

If you do not have Samsung Mobile Print Manager installed on your 
cellphone, go to the application store (Samsung Apps, Play Store) on your 
mobile device, and just search for download the app and try again.

 

3 Mobile device Samsung Mobile Print Manager screen appears.

Press Wi-Fi Setup.

4 Type in the ID and Password, then click OK.

If necessary, type in the ID and Password to log in. If it’s your first time 
logging into the printer, type in the below default ID and password. We 
recommend you to change the default password for security reasons.

• ID: admin

• Password: sec00000 

 

If you want to create a new user or change the password, see "Security tab" 
on page 208.
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5 If the access point (or wireless router) is connected to the connection 
confirmation window appears, then click OK.

If the access point (or wireless router) not connection, select the desired 
access point (or wireless router) and click OK, then click OK.

6 Tag your mobile device (usually located on the back of the mobile 
device) over the NFC tag( ) on your printer.

Wait few seconds for the mobile device to connect to the printer.

 

For some mobile devices, NFC tag might not be located at the back of the 
mobile device. Check the location of the NFC antenna on your mobile 
device before tagging.

 

7 Follow the instruction on the mobile device’s screen.
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Using the Samsung Mobile Print App

Samsung Mobile Print is a free application that enables users to print, 
scan(Only users with multi-functional printers), or fax(Only users with multi-
functional printers) photos, documents, and web pages directly from your 
smartphone or tablet.

Printing

1 Check that NFC and Wi-Fi Direct features are enabled on your mobile 
device and Wi-Fi Direct feature is enabled on your printer.

2 Open Samsung Mobile Print app.

 

If you do not have Samsung Mobile Print installed on your cellphone, go 
to the application store (Samsung Apps, Play Store, App Store) on your 
mobile device, and just search for download the app and try again.

 

3 Select print mode.

4 Select the content you want to print.

If necessary, change the print option by pressing the  icon.
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5 Tag your mobile device (usually located on the back of the mobile 
device) over the NFC tag( ) on your printer.

Wait a few seconds for the mobile device to send a job to the printer.

 

For some mobile devices, NFC tag might not be located at the back of the 
mobile device. Check the location of the NFC antenna on your mobile 
device before tagging.

 

6 The printer starts printing.
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Registering Google Cloud Printer

1 Check that NFC and Wi-Fi Direct features are enabled on your mobile 
device and Wi-Fi Direct feature is enabled on your printer (see "Setting 
the Wi-Fi Direct for mobile printing" on page 148).

2 Open Samsung Mobile Print app.

 

If you do not have Samsung Mobile Print installed on your cellphone, go 
to the application store (Samsung Apps, Play Store, App Store) on your 
mobile device, and just search for download the app and try again.

 

3 Select device status icon.

4 Select Google Cloud Print > Register Google Cloud Printer.
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5 Tag your mobile device (usually located on the back of the mobile 
device) over the NFC tag( ) on your printer.

Wait a few seconds for the mobile device to connect to the printer.

 

For some mobile devices, NFC tag might not be located at the back of the 
mobile device. Check the location of the NFC antenna on your mobile 
device before tagging.

 

6 Confirm your printer in pop-up window.

Now your printer is registered with Google Cloud Print™ service.
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Supported Mobile Apps
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Available Apps

• Samsung Mobile Print: Samsung Mobile Print is a free application that 
enables users to print, scan(Only users with multi-functional printers), or 
fax(Only users with multi-functional printers) photos, documents, and web 
pages directly from your smartphone or tablet. Samsung Mobile Print is 
not only compatible with your Android and iOS smart phones but also with 
your iPod Touch and tablet PC. It connects your mobile device to a network 
connected Samsung printer or to a wireless printer through a Wi-Fi access 
point. Installing a new driver or configuring network settings isn’t necessary 
– just simply install the Samsung Mobile Print application, and it will 
automatically detect compatible Samsung printers. Besides printing photos, 
web pages, and PDFs, scanning is also supported. If you have a Samsung 
multifunction, scan any document into a JPG, PDF, or PNG format for quick 
and easy viewing on your mobile device (see "Using the Samsung Mobile 
Print App" on page 157).

• Samsung Mobile Print Pro: Helps users to get an authentication easily. This 
app provides one way of getting a user authentication using your mobile 
device (see "Using the Samsung Mobile Print Pro App" on page 152).

• Samusng Mobile Print Manager: Enables users to use cloning and wireless 
setup features using your mobile device (see "Using the Samsung Mobile 
Print Manager App" on page 154, "Wireless Setup" on page 156).
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Downloading Apps

To download apps, go to the application store (Play Store, App Store) on your 
mobile device, and just search for “Samsung Mobile Print /Samsung Mobile 
Print Pro/Samusng Mobile Print Manager.” You can also visit iTunes for Apple 
devices on your computer.

• Samsung Mobile Print

- Android:  Search for Samsung Mobile Print from Play Store, and then 
download the app.

- iOS: Search for Samsung Mobile Print from App Store, and then 
download the app.

• Samsung Mobile Print Pro/Samusng Mobile Print Manager

- Android:  Search for Samsung Mobile Print Pro or Samusng Mobile 
Print Manager from Play Store, and then download the app.
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Supported Mobile OS 

• Samsung Mobile Print

- Android OS 2.3 or higher 

- iOS 5.0 or higher

• Samsung Mobile Print Pro/Samusng Mobile Print Manager

- NFC and Wi-Fi Direct enabled, supported mobile apps installed mobile 
device with Android 4.0 or higher
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Mopria™
 

Only Mopria-certified machines can use the Mopria feature. Check the box 
that your machine came in for the Mopria-certified logo.
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Setting up the machine for Mopria printing

Bonjour(mDNS) and IPP protocols are required on your machine to use the 
Mopria feature. Perform the following steps to enable the Mopria feature.

1 Ensure that the machine is connected to the network.

2 On your computer, open a web browser (Internet Explorer, Safari, or 
Firefox) and type the IP address of the machine in the address bar. Then, 
press Enter.

For example,

3 Click Login in the top right corner of the SyncThru™ Web Service 
website.

4 Type in your ID and Password and select the Domain. then click LOGIN. 
Use the same login ID, password, and domain as when your log in from 
the machine (see "Using SyncThru™ Web Service" on page 207.)

 

If you want to create a new user or change the password, see "Security tab" 
on page 208.

 

5 When the SyncThru™ Web Service window opens, click Settings > 
Network Settings > Standard TCP/IP, LPR, IPP > IPP. Then, select 
Enable.

6 Click Settings > Network Settings > mDNS. Then, select Enable.

7 Click Security > System Security > Feature Management > Mopria. 
Then, select Enable.
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Setting up Mopria on your mobile device

If you do not have Mopria Print Service app installed on your mobile device, 
open to the app store (Play Store, App Store) on your mobile device, search 
for,Mopria Print Service, and then download and install the app.

Mopria™ Print Service is a mobile printing solution that enhances 
the new print functionality on any Android phone or tablet 
(Android version 4.4 or later). With this service, you can connect 
and print to any Mopria-certified printer on the same network as 
your mobile device without additional set-up. Many native 
Android apps support printing, including Chrome, Gmail, Gallery, 
Drive and Quickoffice.
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1 In the Settings menu of your Android device, tap Printing.

 

The location of this option may differ depending on your mobile device. If 
you cannot locate the Printing option, refer to the user's manual for your 
mobile device.

 

2  Under Print Services, tap Mopria Print Service.

3 Tap the On/Off slider to enable the Mopria Print Service.
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Printing via Mopria

To print via Mopria on an Android device:

1 Open the email, photo, web page, or document that you want to print.

2 Tap Print on the menu in the app.

3 Select your printer, and then configure the print options.

4 Touch Print again to print the document.

 

To cancel a print job: Select and delete the document from the print queue 
in the Notification Bar.
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AirPrint
 

Only AirPrint certified machines can use the AirPrint feature. Check the box 
your machine came in for the AirPrint certified mark.
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Setting up AirPrint

Bonjour(mDNS) and IPP protocols are required on your machine to use the AirPrint 
feature. You can enable the AirPrint feature by one of the following methods.

1 Check whether the machine is connected to the network.

2 Start a web browser such as Internet Explorer, Safari, or Firefox and enter 
your machine’s new IP address in the browser window.

For example,

3 Click Login in the upper right of the SyncThru™ Web Service website.

4 Type in the ID and Password, then click Login. If it’s your first time logging 
into SyncThru™ Web Service, type in the below default ID and password. We 
recommend you to change the default password for security reasons.

• ID: admin

• Password: sec00000 

 

If you want to create a new user or change the password, see "Security tab" 
on page 208.

 

5 When the SyncThru™ Web Service window opens, click Settings > 
Network Settings.

6 Click AirPrint .
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Printing via AirPrint

For example, the iPad manual provides these instructions:

1 Open your email, photo, web page, or document you want to print.

2 Touch the action icon( ).

3 Select your printer driver name and option menu to set up.

4 Touch Print button. Print it out.
 

Cancelling print job: To cancel the printing job or view the print summary, click the 

print center icon ( ) in multitasking area. You can click cancel in the print center.

 

AirPrint allows you to directly from iPhone, iPad, and iPod touch 
running the latest version of iOS.
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Samsung Cloud Print
Samsung Cloud Print is a free cloud service that allows you to print or scan from 
your smartphone or tablet to your Samsung printer or MFP. After installing the 
Samsung Cloud Print app, you can register with the Samsung Cloud Print service 
just using your mobile number for authentication. No other account login is 
required, although you can link the app to your Samsung Account if you wish.

 

If you press the ( ) button from Samsung Cloud Print app, Your mobile 

device and printer or MFP can be paired , QR code, or by manually entering 
its MAC address. Once paired, you can print or scan from anywhere and 
everywhere.

 

33 

Registering your Printer to Samsung Cloud server.

Registering from Web Browser

 

• Make sure the printer machine is turned on and connected to a wired or 
wireless network that has access to the Internet.

 

1 Open Web browser.

2 Enter your printer’s IP address in the address field and press the Enter key 
or click Go.

3 Click Login in the upper right corner of the SyncThru™ Web Service 
website.

4 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and Password. 
We recommend you to change the default password for security 
reasons.

• ID: admin

• Password: sec00000

 

If you want to create a new user or change the password, see "Security tab" 
on page 208.

 

5 When the SyncThru™ Web Service window opens, click Settings > 
Network Settings > Samsung Cloud Print.

6 Enable Samsung Cloud Print Protocol.

7 Now your printer is registered with Samsung Cloud Print service.
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Printing with Samsung Cloud Print

 

Make sure the printer is turned on and connected to a wired or wireless 
network that has access to the Internet.

 

Registering a printer from an application on mobile 
device

The following steps are an example of using the Samsung Cloud Print app from 
Android mobile phone.

1 Open Samsung Cloud Print app.

 

If you do not have Samsung Cloud Print app installed on your cellphone, 
go to the application store (Samsung Apps, Play Store, App Store) on your 
mobile device, and just search for download the app and try again.

 

2 Press the ( ) button from Samsung Cloud Print app.

3 Your mobile device and printer or MFP can be paired NFC tapping, QR 
code or by manually entering its MAC address.

Printing from an application on mobile device

The following steps are an example of using the Samsung Cloud Print app from 
Android mobile phone.

1 Open Samsung Cloud Print app.

 

If you do not have Samsung Cloud Print app installed on your cellphone, 
go to the application store (Samsung Apps, Play Store, App Store) on your 
mobile device, and just search for download the app and try again.

 

2 Tap the option check button of the document that you want to print.

3 Set the printing options if you want.

4 Tap Send Job.
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Google Cloud Print™
Google Cloud Print™ is a service that allows you to print to a printer using your 

smart phone, tablet, or any other web-connected devices. Just register your 
Google account with the printer, and you are ready to use the Google Cloud 
Print™ service. You can print your document or email with Chrome OS, Chrome 
browser, or a Gmail™/ Google Docs™ application on your mobile device, so you 

don’t need to install the printer driver on the mobile device. Refer to the Google 
website (http://www.google.com/cloudprint/learn/or http://
support.google.com/cloudprint) for more information about Google Cloud 
Print™.
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Registering your Google account to the printer

 

• Make sure the printer machine is turned on and connected to a wired or 
wireless network that has access to the Internet.

• You should create your Google account in the advance.

 

1 Open the Chrome browser.

2 Visit www.google.com.

3 Sign in to the Google website with your Gmail™ address.

4 Enter your printer’s IP address in the address field and press the Enter key 
or click Go.

5 Click Login in the upper right corner of the SyncThru™ Web Service 
website.

6 If it’s your first time logging into SyncThru™ Web Service you need to 
log-in as an administrator. Type in the below default ID and Password. 
We recommend you to change the default password for security 
reasons.

• ID: admin

• Password: sec00000 

 

If the network environment is using a proxy server, you need to configure 
the proxy’s IP and port number from Settings > Network Settings > 
Google Cloud Print > Proxy Setting. Contact your network service 
provider or network administrator for more information.

 

7 When the SyncThru™ Web Service window opens, click Settings > 
Network Settings > Google Cloud Print.

8 Enter your printer’s name and description.

9 Click Register.

The confirmation pop-up window appears.

 

If you set the browser to block pop-ups, the confirmation window will not 
appear. Allow the site to show pop-ups.

 

10 Click Finish printer registration.

http://www.google.com/cloudprint/learn/
http://www.google.com/cloudprint/learn/
http://support.google.com/cloudprint
http://support.google.com/cloudprint
http://www.google.com
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11 Click Manage your printers.

Now your printer is registered with Google Cloud Print™ service.

Google Cloud Print™-ready devices will appear in the list.
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Printing with Google Cloud Print™

The printing procedure varies depending on the application or the device you 

are using. You can see the application list that supports Google Cloud Print™ 
service.

 

Make sure the printer is turned on and connected to a wired or wireless 
network that has access to the Internet.

 

Printing from an application on mobile device

The following steps are an example of using the Google Docs™ app from 
Android mobile phone.

1 Install the Cloud Print application on your mobile device.

 

If you do not have the application, download it from the application store 

such as Android Market or App Store.

 

2 Access the Google Docs™ application from your mobile device.

3 Tap the option  button of the document that you want to print.

4 Tap the send  button.

5 Tap the Cloud Print  button.

6 Set the printing options if you want.

7 Tap Click here to Print.

Printing from the Chrome browser

The following steps are an example of using the Chrome browser.

1 Run Chrome.

2 Open the document or email that you want to print.

3 Click the wrench icon  in the browser’s top right corner.

4 Click Print. A new tab for printing appears.

5 Select Print with Google Cloud Print.

6 Click the Print button.



3. Useful Setting Menus
This chapter explains how to browse the current status of your machine, and the method of setting for advanced 
machine setup.

• Before you begin reading a chapter 169
• Information 170 
• Layout 171 
• Paper 172 
• Graphic 173 
• System Setup 174 
• Emulation 177 
• Image Management 178 
• Network 179 
• Direct USB 180 
• Job Management 181 
• Admin Setup 182 



1693.  Useful Setting Menus

Before you begin reading a chapter
This chapter explains all the features available for this series' models to help users easily understand the features.

You can check the features available for each model in the Basic Guide (see "Menu overview" on page 26).

The following are tips for using this chapter

• The control panel provides access to various menus to set up the machine or use the machine’s functions. These menus can be accessed by pressing Menu( ) 
or from the touch screen.

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• For models that do not have the Menu( ).

• Some menu names may differ from your machine depending on its options or the models.
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Information
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 26).

 

To change the menu options:

• Press Menu( ) > Information on the control panel.

Item Description

Configuration

Prints a report on the machine's overall configuration.

 

If the configuration report includes a QR code, 
then you can scan the code with your 
smartphone or tablet to see information about 
the printer. You can also use the QR code to 
register the printer in Samsung Cloud Print™ (see 
"Samsung Cloud Print" on page 164).

 

Demo Page
Prints the demo page to check whether your machine is 
printing properly or not.

Network 
Configuration

Prints a report on the machine's current network 
configuration.

Supplies 
Information

Prints supplies’ information page.

Usage Counter
Prints a usage page. The usage page contains the total 
number of pages printed.

Account
Prints a report of printout counts for each user. This is 
only available when Job Accounting is enabled from the 
SyncThru™ Web Admin Service.

Menu Map
Prints the menu map which shows the layout and current 
settings of this machine.

PCL Font Prints the PCL font list.

PS Font Prints the PS font list.

Item Description
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Layout
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 26).

 

To change the menu options:

• Press Menu( ) > Layout on the control panel.

Item Description

Orientation

Selects the direction in which information is printed on a 
page.

• Portrait

• Landscape

Margin

• Common Margin: Sets the margin for each side of 
paper.

• MP Tray: Sets the paper margins in multi-purpose tray.

• <Tray X>: Sets the paper margins for the paper trays.

• Emulation Margin: Sets the paper margins for 
emulation print page.

Duplex

To print on both sides of the paper, choose the binding 
edge.

• Off: Disables this option.

• Long Edge

• Short Edge

Item Description
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Paper
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 26).

 

To change the menu options:

• Press Menu( ) > Paper on the control panel.

Item Description

Copies Selects the number of copies.

MP Tray/ Tray[x]a

a. [tray type] indicates the tray number.

• Paper Size: Selects the paper size currently 
loaded in the tray.

• Paper Type: Selects the paper type currently 
loaded in the tray.

Paper Source

Sets the default paper tray to use.

 

Auto: Automatically locates the tray with 
the same sized paper as an original.

 

Tray Confirm

Activates the tray confirmation message. If you 
open and close a tray, a window asking you whether 
to set the paper size and type for the tray just 
opened appears.
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Graphic
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 26).

 

To change the menu options:

• Press Menu( ) > Graphic on the control panel.

Item Description

Resolution
Specifies the number of dots printed per inch (dpi). The 
higher the setting, the sharper printed characters and 
graphics.

Clear Text Prints text darker than on a normal document.

Edge Enhancement
Allows user to enhance sharpness of text and graphics for 
improving readability.

Auto CR
Allows you to append the required carriage return to 
each line feed, which is useful for Unix or DOS users.
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System Setup
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 26).

 

To change the menu options:

• Press Menu( ) > System Setup on the control panel.

Item Description

Date & Time Sets the date and time.

Date Format Sets the date format.

Clock Mode
Selects the format for displaying time between 12 
hours and 24 hours.

Language
Sets the language of the text that appears on the 
control panel display.

Default Paper You can set the default paper size to use.

Power Save

Sets how long the machine waits before going to 
power save mode.

When the machine does not receive data for an 
extended period of time, power consumption is 
automatically lowered.

Wakeup Event

When this option is On, you can wake up the machine 
from the power saving mode with the following 
actions:

• Loading paper in a tray.

• Opening or closing the front cover.

• Pulling a tray out or pushing a tray in.

Job Timeout

When there is no input for a certain period of time, the 
machine cancels the current job. You can set the 
amount of time the machine will wait before canceling 
the job.

Held Job Timeout
You can set the time to hold the temporarily stopped 
job.

Altitude Adjustment
Optimize print quality according to the machine’s 
altitude ("Altitude adjustment" on page 184).

Humidity
Optimizes print quality according to the humidity in the 
environment.

Job Rescheduling

When a job is paused due to a paper mismatch or paper 
empty error, the Job Rescheduling feature switches 
from the paused job to the next job if the next job can 
be printed without any paper errors.

Item Description
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Auto Continue

Determine whether or not the machine continues 
printing when it detects the paper does not match the 
paper settings.

• 0 Sec: This option allows you to continue printing 
when the paper size you have set is mismatched 
with the paper in the tray.

• 30 Sec: If a paper mismatch occurs, an error message 
will display. The machine waits for about 30 second, 
then automatically clear the message and continue 
printing.

• Off: If a paper mismatch occurs, the machine waits 
until you insert the correct paper.

Auto Tray Switch

Determine whether or not the machine continues 
printing when it detects the paper does not match. For 
example, if both tray 1 and tray 2 are filled with the 
same size paper, the machine automatically prints from 
tray 2 after the tray 1 runs out of paper.

 

This option does not appear if you selected 
Auto for Paper Source from printer driver.

 

Paper Substitution

Automatically substitutes the printer driver’s paper size 
to prevent the paper mismatch between Letter and A4. 
For example, if you have A4 paper in the tray but you 
set the paper size to Letter in the printer driver, the 
machine prints on A4 paper and vice versa.

Item Description

Tray Protection
Decides to use or not use the Auto Tray Switch feature 
for a certain tray. If you set tray 1 to on, for example, 
then tray 1 is excluded during tray switching.

Tray Mode

• Dynamic: If you open and close the tray when a 
paper mismatch occurs, the paper settings (size and 
type) for that tray automatically change to the 
settings required for the job. (When you open and 
close the tray in the Dynamic mode, the machine 
presumes that the paper in the tray was replaced 
with the size and type required for the job.)

Skip Blank Pages
The printer detects the printing data from computer 
whether a page is empty or not. You can set to print or 
skip the blank page.

Maintenance

• CLR Empty Msg.: When toner cartridge is empty, 
this option appears. You can clear the empty 
message.

• Supplies Life: Allows you to check how many pages 
are printed and how much toner is left in the 
cartridge.

• RAM Disk: Enables/disables RAM disk to manage 
jobs.

• Paper Low Alert: Allows you to set the alarm for 
when the paper is low.

Item Description
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Toner Save

Activating this mode extends the life of your toner 
cartridge and reduces your cost per page beyond what 
one would experience in the normal mode, but it 
reduces print quality.

Quiet Mode
You can reduce the printing noise by turning this menu 
on. However, the printing speed and quality may be 
declined.

Eco Settings

Allows you to save print resources and enables eco-
friendly printing (see "Eco printing" on page 48).

• Default Mode: Select whether to turn the Eco mode 
on or off.

 

On Force: Sets the Eco mode on. If a user wants 
to turn the Eco mode off, the user needs to 
enter the password.

 

• Select Template: Selects the eco template set from 
the SyncThru™ Web Service.

Item Description

Auto Power Off

Turns power off automatically when the machine has 
been in power save mode for the length of time set in 
Auto Power Off > On > Timeout.

 

• To turn the machine on again, press the  

(Power/Wake Up) button on the control 
panel (make sure the main power switch is 
on).

• If you run the printer driver or Samsung Easy 
Printer Manager, the time automatically 
extends.

• While the machine is connected to the 
network or working on a print job, Auto 
Power Off feature doesn't work.

 

Filing Policy
If the memory already has the same name when you 
entered a new file name, you can rename or overwrite 
it.

Item Description
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Emulation
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 26).

 

To change the menu options:

• Press Menu( ) > Emulation on the control panel.

Item Description

Emulation Type
The machine language defines how the computer 
communicates with the machine.

Setup Sets the detailed settings for the selected emulation type.
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Image Management
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 26).

 

To change the menu options:

• Press Menu( ) > Image Management on the control panel.

Item Description

Custom Color

This menu allows you to adjust contrast, color by color.

• Default: Optimizes colors automatically.

• Print Density: Allows you to manually adjust color 
density for print. Adjust the print density.

It is recommended to use the Default setting for best 
color quality.
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Network
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 26).

 

To change the menu options:

• Press Menu( ) > Network on the control panel.

 

You can also use this feature from the SyncThru™ Web Service. Open the 
Web browser from your networked computer and type the IP address of 
your machine. When SyncThru™ Web Service opens, click Settings > 
Network Settings (see "Using SyncThru™ Web Service" on page 207).

 

Option Description

TCP/IP (IPv4)

Selects the appropriate protocol and configure 
parameters to use the network environment (see "Setting 
IP address" on page 127).

 

There are lots of parameters to be set. If you are 
not sure, leave as is, or consult the network 
administrator.

 

TCP/IP (IPv6)
Selects this option to use the network environment 
through IPv6 (see "IPv6 configuration" on page 137).

Ethernet

Configure the ethernet port and network transmission 
speed.

 

Turn the power off and on after you change this 
option.

 

802.1x
You can select the user authentication for network 
communication. For detailed information consult the 
network administrator.

Wi-Fi
Select this option to use the wireless network (see 
"Wireless network setup(Optional)" on page 139).

Protocol 
Management

You can activate or deactivate the protocols.

 

Turn the power off and on after you change this 
option.

 

Network 
Configuration

This list shows information on your machine’s network 
connection and configuration (see "Printing a network 
configuration report" on page 127).

Clear Setting

Reverts the network settings to the default values.

 

Turn the power off and on.

 

Option Description
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Direct USB
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 26).

 

To change the menu options:

Item Description

Print From Select a file to print.

File Manage Select a file to delete. You can format the USB device.

Show Space Shows the remaining space.
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Job Management
 

Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" on 
page 26).

 

To change the menu options:

Item Description

Active Job Displays the list of jobs in progress and pending.

Secure Job Displays the list of jobs that are secured on the disk

Stored Job Displays the list of jobs that are stored on the disk.
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Admin Setup
 

• Some menus may not appear in the display depending on options or 
models. If so, it is not applicable to your machine (see "Menu overview" 
on page 26).

• You need to enter a password to enter this menu. The default password 
is sec00000.

 

To change the menu options:

• Press Menu( ) > Admin Setup on the control panel.

Item Description

Stamp

You can apply the stamp feature.

• Stamp Activate: You can activate stamp feature.
• Item: You can select the items to print on the printout 

such as time, date, and etc.
• Text Size: You can select the text size such as small, 

normal, large.
• Opacity: You can select the stamp transparency.
• Position: Sets the stamp position.

Change Admin 
Password

Changes the machine’s password for accessing the Admin 
Setup.

Firmware Upgrade
To upgrade the latest firmware, turn this option "On" and 
then download the firmware file.

Import Setting
Imports data stored on a USB memory stick to the machine 
(see "Backing up data" on page 53).

Export Setting
Exports data stored on the machine stick to a USB memory 
(see "Restoring data" on page 53).

Secure Print

You can set the login method of secure print.

 

This option is available when the System Setup > 
Maintenance > RAM Disk is enabled.

 

Supplies 
Management

• Toner Low Alert: If toner in the cartridge has run out, a 
message informing the user to change the toner 
cartridge appears. You can set the option for this 
message to appear or not.

Item Description



4. Special Features
This chapter explains special printing features.

• Altitude adjustment 184
• Entering various characters 185
• Printing features 186
 

• The procedures in this chapter are mainly based on Windows 7.

• It may be necessary to press OK to navigate to lower-level menus for some models.
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Altitude adjustment
Print quality is affected by atmospheric pressure, which is determined by the 
height of the machine above sea level. The following information will guide you 
on how to set your machine for the best print quality.

Before you set the altitude value, determine the altitude where you are.

• Normal: 0-1,000 m(3,280 ft)

• High1: 1,000 m(3,280 ft)-2,000 m(6,561 ft)

• High2: 2,000 m(6,561 ft)-3,000 m(9,842 ft) 

• High3: 3,000 m(9,842 ft)-4,000 m(13,123 ft)

• High4: 4,000 m(13,123 ft)-5,000 m(16,404 ft)

You can set the altitude value from Device Settings in Samsung Easy Printer 

Manager program.

• For Windows and Mac users, you set from Samsung Easy Printer Manager > 

Advanced Setting > Device Settings (see "Using Samsung Easy Printer 
Manager" on page 214).

 

• If your machine is connected to the network, you can set the altitude via 
SyncThru™ Web Service (see "Using SyncThru™ Web Service" on page 
207).

• You can also set the altitude in System Setup > Altitude Adjustment on 
the control panel (see "Machine’s basic settings" on page 30).
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Entering various characters
As you perform various tasks, you may need to enter names and numbers.

1 

Entering alphanumeric characters

Press the button until the correct letter appears on the display. For example, to 
enter the letter O, press 6, labeled with MNO. Each time you press 6, the display 
shows a different letter, M, N, O, m, n, o and finally 6. To find the letter that you 
want to enter, see "Keypad letters and numbers" on page 185.

 

• You can enter a space by pressing 1 twice.

• To delete the last digit or character, press the arrow button.

 

2 

Keypad letters and numbers

 

• Special character sets may differ from your machine depending on its 
options or the models.

• Some of the follow key values may not appear depending on the job you 
are doing.

 

Key Assigned numbers, letters, or characters

1 @ / . ’ 1

2 A B C a b c 2

3 D E F d e f 3

4 G H I g h i 4

5 J K L j k l 5

6 M N O m n o 6

7 P Q R S p q r s 7

8 T U V t u v 8

9 W X Y Z w x y z 9

0 & + - , 0

* * % ^ _ ~ ! # $ ( ) [ ]

(These symbols are available when you type for network authentication.)

# # = | ? " : { } < > ;

(These symbols are available when you type for network authentication.)
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Printing features
 

• For basic printing features, refer to the Basic Guide (see "Basic printing" 
on page 45).

• This feature may not be available depending on model or optional goods 
(see "Features by model" on page 7).

 

3 

Changing the default print settings

1 Click the Windows Start menu.

2 Select Control Panel > Devices and Printers.

3 Right-click on your machine.

4 Select Printing preferences.

 

If Printing preferences has a ▶, you can select other printer drivers 
connected to the selected printer.

 

5 Change the settings on each tab.

6 Click OK.

 

If you want to change the settings for each print job, change it in Printing 
Preferences.

 

4 

Setting your machine as a default machine

1 Click the Windows Start menu.

2 Select Control Panel > Devices and Printers.

3 Select your machine.

4 Right-click your machine and select Set as Default Printer.

 

If Printing preferences has a ▶, you can select other printer drivers 
connected to the selected printer.
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5 

Using advanced print features

 

• XPS printer driver: used to print XPS file format.

- See "Features by model" on page 7.

- The XPS printer driver can be installed only on Windows Vista OS or 
higher.

- For models that provide XPS driver from the Samsung website, http:/
/www.samsung.com  > find your product> Support or downloads.

 

Printing to a file (PRN)

You will sometimes need to save the print data as a file.

1 Check the Print to file box in the Print window.

2 Click Print.

3 Type in the destination path and the file name, and then click OK.

For example, c:\Temp\file name.

 

If you type in only the file name, the file is automatically saved in My 
Documents, Documents and Settings, or Users. The saved folder may 
differ, depending on your operating system or the application you are 
using.

 

http://www.samsung.com
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Understanding special printer features

You can use advanced printing features when using your machine.

To take advantage of the printer features provided by your printer driver, click Properties or Preferences in the application’s Print window to change the print 
settings. The machine name, that appears in the printer properties window may differ depending on the machine in use.

 

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• Select the Help menu or press F1 on your keyboard and click on any option you want to know about (see "Using help" on page 47).

 

 

Item Description

Multiple Pages per 
Side

Selects the number of pages to print on a single sheet of paper. To print more than one page per sheet, the pages will be reduced in size and 
arranged in the order you specify. You can print up to 16 pages on one sheet.

Poster Printing
Prints a single-page document onto 4 (Poster 2x2), 9 (Poster 3x3), or 16 (Poster 4x4) sheets of paper, for the purpose of pasting the sheets 
together to form one poster-size document.

Select the Poster Overlap value. Specify Poster Overlap in millimeters or inches by selecting the radio button on the upper right of Basic tab 
to make it easier to paste the sheets together.
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Booklet Printinga

Prints your document on both sides of a sheet of paper and arranges the pages so that the paper can be folded in half after printing to produce 
a booklet.

 

• If you want to make a booklet, you need to print on Letter, Legal, A4, US Folio, or Oficio sized print media.

• The Booklet Printing option is not available for all paper sizes. Select the available paper Size option under the Paper tab to see what 
paper sizes are available.

• If you select an unavailable paper size, this option can be automatically canceled. Select only available paper (paper without  or  
mark).

 

Double-sided 
Printing

Print on both sides of a sheet of paper (duplex). Before printing, decide how you want your document oriented.

 

You can use this feature with Letter, Legal, A4, US Folio or Oficio sized paper 

 

Item Description

8 9
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Double-sided 
Printing

 

Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

 

• Printer Default: If you select this option, this feature is determined by the settings you have selected on the control panel of the machine.

• None: Disables this feature.

• Long Edge: This option is the conventional layout used in bookbinding.

• Short Edge: This option is the conventional layout used in calendars.

• Reverse Double-Sided Printing: Check this option to reverse the print order when duplex printing.

Paper Options Changes the size of a document to appear larger or smaller on the printed page by entering in a percentage by which to enlarge or decrease the 
document.

Item Description
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Watermark The watermark option allows you to print text over an existing document. For example, you use it when you want to have large gray letters 
reading “DRAFT” or “CONFIDENTIAL” printed diagonally across the first page or all pages of a document.

Watermark

(Creating a 
watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears.
c Enter a text message in the Watermark Message box.

You can enter up to 256 characters. The message displays in the preview window.

Watermark

(Editing a watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears.
c Select the watermark you want to edit from the Current Watermarks list and change the watermark message and options.
d Click Update to save the changes.
e Click OK or Print until you exit the Print window.

Watermark

(Deleting a 
watermark)

a To change the print settings from your software application, access Printing Preferences.
b Click the Advanced tab, select Edit from the Watermark drop-down list. The Edit Watermarks window appears. 
c Select the watermark you want to delete from the Current Watermarks list and click Delete. 
d Click OK or Print until you exit the Print window.

Item Description
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Overlaya

This option is available only when you use the PCL/SPL printer driver (see "Software" on page 7).

An overlay is text and/or images stored in the computer hard disk drive (HDD) as a special file format that can be printed on any document. 
Overlays are often used to take the place of letterhead paper. Rather than using preprinted letterhead, you can create an overlay containing 
exactly the same information that is currently on your letterhead. To print a letter with your company’s letterhead, you do not need to load 
preprinted letterhead paper in the machine: just print the letterhead overlay on your document.

To use a page overlay, you must create a new page overlay containing your logo or image.

 

• The overlay document size must be the same as the document you print with the overlay. Do not create an overlay with a watermark.

• The resolution of the overlay document must be the same as that of the document you will print with the overlay.

 

Overlaya

(Creating a new page 
overlay)

a To save the document as an overlay, access Printing Preferences.
b Click the Advanced tab, and select Edit from the Text drop-down list. Edit Overlay window appears.
c In the Edit Overlay window, click Create.
d In the Save As window, type a name up to eight characters in the File name box. Select the destination path, if necessary (The default is 

C:\Formover).
e Click Save. The name appears on the Overlay List.
f Click OK or Print until you exit the Print window.

The file is not printed. Instead, it is stored on your computer hard disk drive.

Item Description
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Overlaya

(Using a page overlay)

a Click the Advanced tab.
b Select the desired overlay from the Text drop-down list.
c If the overlay file you want does not appear in the Text drop-down list, select Edit... from the list and click Load. Select the overlay file you 

want to use.
If you have stored the overlay file you want to use in an external source, you can also load the file when you access the Open window.
After you select the file, click Open. The file appears in the Overlay List box and is available for printing. Select the overlay from the Overlay 
List box.

d If necessary, check Confirm Page Overlay When Printing box. If this box is checked, a message window appears each time you submit a 
document for printing, asking you to confirm printing an overlay on your document.
If this box is not checked and an overlay has been selected, the overlay automatically prints with your document.

e Click OK or Print until you exit the Print window.

Overlaya

(Deleting a page 
overlay)

a In the Printing Preferences window, click the Advanced tab.
b Select Edit in the Text drop down list.
c Select the overlay you want to delete from the Overlay List box.
d Click Delete.
e When a confirming message window appears, click Yes.
f Click OK or Print until you exit the Print window. You can delete page overlays that you no longer use.

Item Description
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Print Mode

 

•  This feature is available only if you have installed the optional memory or mass storage device (HDD) (see "Variety feature" on page 7).

• Some menus may not appear on the display depending on options or models. If so, it is not applicable to your machine.

• To enable this feature, check Storage Options (see "Setting Device Options" on page 65).

• Without installing the optional memory or mass storage device (HDD) in the machine, the RAM disk feature provides only 3 options: 
Normal, Proof, and Confidential.

 

• Print Mode: The default Print Mode is Normal, which is for printing without saving the printing file in the memory.

- Normal: This mode prints without storing your document in the optional memory.

- Proof: This mode is useful when you print more than one copy. You can print one copy first to check, then print the rest of the copies later.

- Confidential: This mode is used for printing confidential documents. You need to enter a password to print.

 

• Job Name: This option is used when you need to find a stored file using the control panel.

• User ID: This option is used when you need to find a stored file using the control panel. The user name automatically appears as the 
user name that you use to log on Windows.

• Enter Password: If the Property of the document you selected is secured, you have to enter the password for the document. This 
option is used for loading a stored file using the control panel.

• Confirm Password: Re-enter the password to confirm it.

 

Item Description
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Job Accounting

This option allows you to print with the given permission.

• User permission: If you check this option, only users with user permission can start a print job.

• Group permission: If you check this option, only groups with group permission can start a print job.

 

• Select the Help menu or press F1 on your keyboard and click on any option you want to know about (see "Using help" on page 47).

• Administrators can enable job accounting and configure permissions in the control panel or SyncThru™ Web Admin Service.

 

a. This option is not available when you use XPS driver.

Item Description
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Using Direct Printing Utility

 

•  Direct Printing Utility may not be available depending on model or 
optional goods (see "Software" on page 7).

• Available for Windows OS users only.

 

What is Direct Printing Utility?

Direct Printing Utility is a program that sends the PDF files directly to your 
machine to print without having to opening the file.

To install this program:

Download the software from the Samsung website then unpack and install it: 
(http://www.samsung.com > find your product > Support or Downloads).
 

• You cannot print PDF files that are restricted. Deactivate the printing 
restriction feature and retry printing.

• You cannot print PDF files that are restricted by a password. Deactivate 
the password feature, and retry printing.

• Whether or not a PDF file can be printed using the Direct Printing Utility 
program depends on how the PDF file was created.

• The Direct Printing Utility program supports PDF version 1.7 and below. 
For higher versions, you must open the file to print it.

 

Printing

There are several ways you can print using the Direct Printing Utility.

1 From the Start menu select Programs or All Programs .

• For Windows 8, from Charms, select Search > Apps.

2 Find Samsung Printers > Direct Printing Utility.

3 Select your machine from the Select Printer drop-down list and click 
Browse.

4 Select the file you wish to print and click Open.

The file is added in the Select Files section.

5 Customize the machine settings for your needs.

6 Click Print. The selected PDF file is sent to the machine.

Using the right-click menu

1 Right-click on the PDF file to print and select Direct Printing.

The Direct Printing Utility window appears with the PDF file is added.

2 Select the machine to use.

3 Customize the machine settings.

4 Click Print. The selected PDF file is sent to the machine.

http://www.samsung.com
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Mac printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.

 

Printing a document

When you print with a Mac, you need to check the printer driver settings in each 
application you use. Follow the steps below to print from a Mac:

1 Open the document to print.

2 Open the File menu and click Page Setup (Document Setup in some 
applications).

3 Choose your paper size, orientation, scaling, other options, and make 
sure that your machine is selected. Click OK.

4 Open the File menu and click Print.

5 Choose the number of copies and indicate which pages to print.

6 Click Print.

Changing printer settings

You can use advanced printing features when using your machine.

Open an application and select Print from the File menu. The machine name, 
which appears in the printer properties window, may differ depending on the 
machine in use. Except for the name, the composition of the printer properties 
window is similar to the following.

Printing multiple pages on one sheet 

You can print more than one page on a single sheet of paper. This feature 
provides a cost-effective way to print draft copies.

1 Open an application, and select Print from the File menu.

2 Select Layout from the drop-down list under Orientation. In the Pages 
per Sheet drop-down list, select the number of pages you want to print 
on one sheet of paper.

3 Select the other options to use.

4 Click Print.

The machine prints the selected number of pages to print on one sheet 
of paper.
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Printing on both sides of the paper

 

Some features may not be available depending on models or options. It 
means that the features are not supported (see "Variety feature" on page 7).

 

Before printing in the duplex mode, decide on which edge you will be binding 
your finished document. The binding options are, as follows:

• Long-Edge Binding: This option is the conventional layout used in book 
binding.

• Short-Edge Binding: This option is the type often used with calendars.

1 From your Mac application, select Print from the File menu.

2 Select Layout from the drop-down list under Orientation.

3 Select a binding orientation from the Two-Sided option.

4 Select the other options to use.

5 Click Print and the machine prints on both sides of the paper.

 

If you print more than 2 copies, the first copy and the second copy might 
print on the same sheet of paper. Avoid printing on both sides of paper 
when you are printing more than 1 copy.

 

Using help

Click the question mark on the bottom-left corner of the window and click on 
the topic you want to know about. A pop-up window appears with information 
about that option's feature, which is provided from the driver.
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Linux printing

 

Some features may not be available depending on models or options. It 
means that the features are not supported.

 

Printing from applications

There are a lot of Linux applications that allow you to print using Common UNIX 
Printing System (CUPS). You can print on your machine from any such 
application.

1 Open the document to print.

2 Open the File menu and click Page Setup (Print Setup for some
applications).

3  Choose your paper size, orientation, and make
sure that your machine is selected. Click Apply.

4  Open the File menu and click Print.

5  Select your machine to print.

6 Choose the number of copies and indicate which pages to print.

7 Change other printing options in each tab, if necessary.

8 Click Print.

 

Automatic duplex printing may not be available depending on models. You 
can alternatively use the lpr printing system or other applications for odd-
even printing (see "Features by model" on page 7).

 

Printing files

You can print text, image, pdf files on your machine using the standard

CUPS directly from the command line interface. The CUPS lp or lpr utility allows 
you to do that. You can print these files by using below command format.

"lp -d <printer name> -o <option> <file name>"

Please refer to lp or lpr man page on your system for more details.

Configuring Printer Properties

You can change the default printing options or connection type with Printing 
utility supplied by o/s.

1 Launch Printing utility(Go to System > Administration > Printing 
menu or execute “system-config-printer” command in Terminal 
program).

2 Select your printer and double-click it.

3 Change default printing options or connection type.



Printing features

2004.  Special Features

4 Click Apply button.
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Some features may not be available depending on models or options. It 
means that the features are not supported (see "Features by model" on 
page 7).

 

Proceeding the print job

After installing the printer, choose any of the image, text, or PS files to print.

1 Execute “printui <file_name_to_print>” command.

For example, if you are printing “document1”

printui document1

This will open the UNIX Printer Driver Print Job Manager in which the user 
can select various print options.

2 Select a printer that has been already added.

3 Select the printing options from the window such as Page Selection.

4 Select how many copies are needed in Number of Copies.

 

To take advantage of the printer features provided by your printer driver, press 
Properties.

 

5 Press OK to start the print job.

Changing the machine settings

The UNIX printer driver Print Job Manager in which the user can select various 
print options in printer Properties.

The following hot keys may also be used: “H” for Help, “O” for OK, “A” for Apply, and 
“C” for Cancel.

General tab

• Paper Size: Set the paper size as A4, Letter, or other paper sizes, according to 
your requirements.

• Paper Type: Choose the type of the paper. Options available in the list box are 
Printer Default, Plain, and Thick.

• Paper Source: Select from which tray the paper is used. By default, it is Auto 
Selection.

• Orientation: Select the direction in which information is printed on a page.

• Duplex: Print on both sides of paper to save paper.


